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PCC MIX DESIGN 
SOFTWARE TUTORIAL 
 
 

(Version 2.4)

For help, comments, and/or suggestions, please contact: 
 
 James M. Krstulovich, Jr. 
 IDOT Bureau of Materials and Physical Research 
 126 East Ash Street 
 Springfield, Illinois 62704 
 Phone: (217) 782-7200 
 email: DOT.PCCMIX@illinois.gov 

 
!!! IMPORTANT !!!  This spreadsheet utilizes macros.  Depending on Excel’s security settings, the macros may 
not be enabled.  To change the macros settings for Excel, refer to the steps found at the end of this tutorial. 
 
 
General 
This spreadsheet is designed to calculate and report PCC mix designs for submittal to IDOT.  The spreadsheet is 
comprised of data inputs based on the mix design methodology provided in the PCC Level III Technician course 
manual. 
 
Buttons are provided for ease of navigation, and their use is recommended as they ensure proper operation 
throughout the design process.  Using the worksheet tabs, found at the bottom of the Excel screen, will also work. 
 
The blue-shaded areas are cells which require data input, green-shaded areas are optional (unless required by 
your District), and white cells are calculation fields, which are password protected from accidental overwriting. 
 
Throughout the spreadsheet, comments have been interspersed to offer hints on where to find relevant 
information.  To view comments, hold the cursor over the red tags found in the upper right hand corner of 
commented cells, as shown below.  These comments generally refer to sections of the Course Manual; however, 
it should be noted that the Department’s Standard Specifications and Special Provisions take precedence. 
 

 

Figure 1.  Example of a comment; note red flag, which indicates the cell has a comment. 
 
 
Tutorial Mix Design 
This tutorial also includes notes for how to input the example mix design discussed in Section 2.9 of the Course 
Manual.  If you follow the notes in order as they are presented herein, you should successfully create a basic 
PCC paving mix design while also being introduced to many of the spreadsheet’s functions and capabilities. 
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Step 1.  Design Information 
The Design Information worksheet is important to establish the who-what-where of the mix design.  This is where 
the designer decides in which units of measure the mix will be designed, what type of concrete it is, for what 
Classes of concrete it is valid, and those responsible for the mix design. 
 

 
 
 
Fit to Screen [button]: Click this button to optimize each page of the mix design spreadsheet for viewing on your 

screen. 
 
English/Metric [toggle]: Toggle button for selecting the units of measure for the mix design’s inputs.  All data 

inputs will have to be entered in the chosen units of measure.  However, the design will 
be reported in both units of measure on the different final mix design reports generated. 

 
EXAMPLE 
PROBLEM 

Assuming most of us are more comfortable using English units of measure (lbs, 
yd3, etc.), the example mix design will be designed using English units. 
 
Click on the ENGLISH toggle button. 

 
Mix Design No.: Alphanumeric designation (up to nine characters in length).  This is the Producer’s or 

Contractor’s self-designated mix design number; this is not the mix design number 
assigned by IDOT, see “IDOT Mix Design No.” below. 

 
EXAMPLE 
PROBLEM 

Because this is the Producer’s or Contractor’s mix design number, any reasonably 
succinct and unique identifier can be used here, as long as it is no more than nine 
characters long. For this example, we will use PMC0001PV (i.e., Pave Masters Co. 
paving mix #1). 

 
IDOT Mix Design No.: Nine character alphanumeric mix design number reported to the Department’s MISTIC 

database.  This number will be assigned by your District to an approved mix design. 
 

EXAMPLE 
PROBLEM 

Because this mix design number is assigned by the District upon approval, this cell 
reads Not yet assigned. 

 
Date Created:  The date the mix design was created. 
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Step 1.  Design Information (continued) 
 
Concrete Code: Select the appropriate material code.  This code is used by the Department’s MISTIC 

database to designate the type of concrete. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize Type I portland cement and Class C fly ash, the 
appropriate Concrete Code to select from the drop-down list is 21605. 

 
Class:   Select up to five Classes of concrete. 
 

EXAMPLE 
PROBLEM 

Because this mix will be used for a continuously reinforced portland cement 
concrete pavement, the appropriate Class to select is PV. 

 
Responsible Location: District responsible for mix design's use; for example, “91” for District 1. 
 

EXAMPLE 
PROBLEM 

Select one of the nine IDOT Districts with which you typically work; for example, 
select 91 if you often work with District 1 in the Chicago area. 

 
Lab: Laboratory associated with the creation and/or testing of the design.  For example: DI for 

district mix designs, or PP for producer mix designs.  Contractors and Producers are to 
use "Producer" Lab codes.  Consultants are to use "Independent" Lab codes. 

 
Company Name: Name of laboratory responsible for creation and/or testing of mix design. 
 
Location:  Nearest municipality to Lab/Company. 
 
Designer:  Name, phone number, and email of person that created the design. 
 
Mix Design Producer: MISTIC producer number and name of producer. 
 
IDOT Engineer: This is the IDOT District representative to whom this mix design should be submitted for 

approval.  Consult your District’s Mixtures Control Engineer for more information.  Use 
the yellow table to the right of the main input area to add names to the drop-down list. 

 
Contract No.: (Optional) Either the five digit contract number, or if it is a local agency contract without a 

five digit number, then enter the MFT (Motor Fuel Tax) contract number. 
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Step 2.   Design Variables 
The Design Variables worksheet is where the designer first begins to determine the mix design’s parameters that 
factor into the mix design’s proportion calculations. 
 

 
 
 
Batch Size:  Batch size in cubic yards (cubic meters).  All mix designs are created per 1 yd3 (1 m3). 
 
Cement Factor: Cement quantity in hundredweight per cubic yard (kilograms per cubic meter).  

Adjustments based on admixture use or underwater placement can be applied using the 
Cement Factor Adjustment table. 

 
EXAMPLE 
PROBLEM 

From Table 2.2.1 in the Course Manual, the cement factor for Class PV concrete 
from a central mixed plant is 5.65 cwt/yd3. 

Also, from Section 2.2.2, a cement factor reduction of 0.30 cwt/yd3 can be applied 
because a water-reducing admixture will be used.  Enter 0.30 in the appropriate box 
of the Cement Factor Adjustment table. 

Thus, the final, adjusted cement factor is reduced to 5.35 cwt/yd3. 
 
Mortar Factor:  Refer to Table 2.8.2.3 Design Mortar Factor in the Course Manual. 
 

EXAMPLE 
PROBLEM 

From Table 2.8.2.3 in the Course Manual, a mortar factor can be selected for Class 
PV concrete. 

Enter 0.83 as a reasonable starting point. 
 
Target Air Content: Percentage of entrained air in the concrete to improve durability.  Refer to Table 2.7.1 Air 

Content in the Course Manual. 
 

EXAMPLE 
PROBLEM 

From Table 2.7.1 in the Course Manual, the midpoint of the air content range for 
Class PV concrete is 6.5%. 

 
Target Slump:  Enter the target slump in inches (mm).  Refer to Table 6.1 Slump in the Course Manual. 
 

EXAMPLE 
PROBLEM 

From Table 6.1 in the Course Manual, the slump range for Class PV concrete is 2 to 
4 inches, except when slipformed, it is 1/2 to 2 1/2 inches (Table 6.1, Note 1). As 
noted in Section 6.1, experience has shown that a slump of 1/2 to 1-1/2 inches at 
the paver is typical for slipformed pavement construction, but many Contractors 
desire 1-1/2 inches to obtain a smooth pavement.  Enter 1.5 inches. 
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Step 2.   Design Variables (continued) 
 
Determine Water Content 
First, using the toggle switch, select either the Standard Method or the w/c Ratio Method. 
 
The Standard method requires the designer to enter fine and coarse aggregate water requirements, as well as 
percent water reduction.  Refer to Section 2.5.1 Water Requirement in the Course Manual for more information. 
 
Alternatively, the w/c Ratio Method will determine mix water based on the water/cement ratio (w/c) entered and 
the total content of cement and finely divided minerals.  No water adjustment needs to be entered as it will be 
back-calculated based on the w/c ratio and aggregate water requirement inputs. 
 
If the Standard Method has been selected, refer to the following inputs: 

 
 

FA Type:  Select fine aggregate type. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize a Type “B” fine aggregate, select B from the 
drop-down list. 

 
FA Water Req.:  Water requirement for fine aggregate in gallons per hundredweight (liters per kilogram) of 
cement and finely divided minerals.  This value is based on the type of fine aggregate.  For example, 5.1 gal/cwt 
(0.426 L/kg) is typical for Type “A” fine aggregate, as shown in the table, Typical FA Water Requirements. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize a Type “B” fine aggregate, the typical water 
requirement is 5.3 gal/cwt. 

 
CA Water Req.:  Water requirement for coarse aggregate in gallons per hundredweight (liters per kilogram) of 
cement and finely divided minerals material.  This value is based on the type of coarse aggregate.  Typical 
values are provided in the table, Typical CA Water Requirements. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize a non-crushed gravel coarse aggregate, the 
typical water requirement is 0.0 gal/cwt. 

 
Water Reduction:  Percentage of water adjustment (typically a reduction) taking into account various factors, 
such as admixture use, cement and finely divided mineral content, air content, etc.  Note that because this input 
is referred to as a “reduction”, the value entered may seem counter-intuitive; that is, a water reduction should be 
entered as a positive value, while a water addition should be entered as a negative value.  For example, enter 
“10.0” for a 10 percent water reduction, and enter “-10.0” for a 10 percent water addition. 
 
For help determining a reasonable water adjustment, click on the button, Water Adjustment Help.  The Water 
Adjustment Help tab is modeled after Table 2.5.2 Adjustment to Basic Water Requirement in the Course 
Manual. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize a water-reducing admixture to provide a target 
water reduction of 6%, enter 6.0. 

Note: If for some reason this mix needed a 6 percent water addition, you 
would have entered -6.0. 
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Step 2.   Design Variables (continued) 
 
If the W/C Ratio Method has been selected: 

 
 
Enter W/C Ratio:  When w/c Ratio Method is toggled, this field appears.  Enter the target water/cement ratio that 
the design water will be based on; for example, 0.42. 
 
It is still important to select the appropriate FA Type, as well enter the CA Water Requirement, so as to allow the 
spreadsheet to back-calculate the water reduction on the final mix design reports. 
 

EXAMPLE 
PROBLEM 

Another way to determine mix water is based on inputting a target 
water/cement ratio (w/c): 

In this example, per Table 2.6.1 in the Course Manual, the maximum w/c 
for Class PV concrete is 0.42. 

Also, by selecting the appropriate fine aggregate type (“B”) and entering a 
reasonable water requirement for the coarse aggregate, the water 
reduction will be back-calculated on the final mix design reports. 

 
 

 
 
Fineness Mod: (Optional) Fineness modulus of the fine aggregate used in the mix design; for example, 

2.36.  Fineness modulus is for informational purposes only; fineness modulus does not 
factor into proportioning calculations. 

 
Admixture:  Choose an admixture type: “W – water reducer”, “S – superplasticizer”, or “R – retarder”. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize a water-reducing admixture to meet the water/cement 
ratio requirement, select W – Water Reducer from the drop-down list. 

 
Fly Ash Class:  Choose the class of fly ash used in the mix design, if applicable. 
 

EXAMPLE 
PROBLEM 

Because this mix will utilize Class C fly ash, select C from the drop-down list.  If this 
example did not utilize any fly ash, you would select “n/a”. 
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Step 3.  Aggregate Information 
The Aggregate Information worksheet is where the designer enters all fine and coarse aggregate information.  
Note that although up to six aggregate materials can be accommodated by this spreadsheet, the Department’s 
MISTIC database only allows a total of six materials, including cement and finely divided minerals.  For example, 
four aggregates, one cement, and one finely divided mineral (e.g., fly ash); or three aggregates, one cement, and 
two finely divided minerals (e.g., fly ash and microsilica). 
 

 
 
 
Material: Aggregate material codes.  Coarse and fine aggregates may be entered in any order, 

except as required by your District.  For more information regarding aggregate material 
codes, refer to form BMPR MI504 “Field/Lab Gradations”. 

 
EXAMPLE 
PROBLEM 

 Fine aggregate: Enter 027FA01 as given in the Course Manual. This material 
code is for an “A” quality natural sand meeting the gradation criteria for FA 1 
per Article 1003.01(c). 

 Coarse aggregate: Enter 020CA07 as given in the Course Manual. This 
material code is for an “A” quality non-crushed gravel meeting the gradation 
criteria for CA 7 per Article 1004.01(c). 

 
Producer Number: Aggregate producer number.  This field is required for all aggregate components. 
 
Producer Name: Aggregate producer name. 
 
Specific Gravity: Saturated Surface Dry (SSD) specific gravity of each aggregate. 
 

EXAMPLE 
PROBLEM 

The example problem as given in the Course Manual indicates that the saturated 
surface-dry specific gravities for the fine and coarse aggregate components are 
2.66 and 2.68, respectively. 
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Step 3.  Aggregate Information (continued) 
 
Agg. Moisture (%): Moisture of aggregates relative to SSD condition.  If the percentage moisture is drier than 

SSD, it must be entered using a negative value (e.g., -1.00). 
 

EXAMPLE 
PROBLEM 

No aggregate moisture is indicated in the example problem as given in the Course 
Manual. Thus, it can be left blank. 

 
% Blend: Percent blend for aggregate components.  If only using one coarse aggregate and one 

fine aggregate material, enter “100” for each.  On the other hand, if blending coarse 
aggregate materials, say, CA 11 and CA 16 at 75 and 25 percent, respectively, enter a 
"75" for the CA 11 and a "25" for the CA 16.  Similarly, if blending fine aggregate 
materials.  Do not blend coarse and fine aggregate, except as noted below for CAM II: 

 
Note for CAM II designs only—Recommended % Blend of coarse-to-fine aggregate: 
50-50 when using CA 7, CA 9, or CA 11; 75-25 when using CA 6; and 100-0 (i.e. no fine 
aggregate) when using CA 10.  For example, when using CA 6 and FA 1, enter “75” for 
the CA 6 and “25” for the FA 1. 

 
EXAMPLE 
PROBLEM 

Because this mix is utilizing one coarse aggregate component and one fine 
aggregate component (and the mix is not CAM II), enter 100 for coarse aggregate 
and 100 for fine aggregate, as well. 

 
 
Step 3a.  Voids in Coarse Aggregate 
The Designer has the option to either enter the Voids directly or calculate Voids by performing ITP 306, Voids 
Test of Coarse Aggregate for Concrete Mixtures, which can be found in the Manual of Test Procedures for 
Materials. However, some Districts may provide a value for general aggregate types, such as “0.36” for gravels. 
 
If calculating the Voids, enter the “% Absorption”, “Net Weight of Aggregate”, and “Volume of Measure” as 
determined while performing ITP 306.  Consult your District for “% Absorption” values.  (The Calibration of 
Measure is not required for every mix design, but is included for convenience.) 
 

 
 
If entering the Voids directly, toggle the “Enter Directly” button and input the appropriate value in the “User-
defined” box.  Important: Enter “1.00” for any mix design that does not contain coarse aggregate. 
 

 
 

EXAMPLE 
PROBLEM 

The example problem as given in the Course Manual notes that the Voids for the 
coarse aggregate is 0.37. 
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Step 4.  Finely Divided Minerals & Admixtures Information 
This worksheet is where the designer enters all information pertaining to cement and finely divided minerals, as 
well as chemical admixtures (e.g. air-entraining water-reducing admixtures, etc.). 
 

 
 
 
Material: Cement and finely divided mineral (FDM) material codes.  Each line is dedicated to a 

specific material: Line 1 for cement, Line 2 for fly ash, Line 3 for GGBF slag, and Line 4 
for miscellaneous (e.g., microsilica, high-reactivity metakaolin, etc.). 

 
EXAMPLE 
PROBLEM 

Because this mix will utilize a Type I cement and Class C fly ash, Lines 1 and 2 will 
be used. 

 Cement: Because this mix is utilizing a Type I cement, select 37601 Type I, 
Portland from the drop-down list. 

 Fly ash: Because this mix is utilizing a Class C fly ash, select 37801 Fly Ash 
Class C from the drop-down list. 

 
Producer Number: Material producer number.  This field is required for all finely divided minerals. 
 
Producer Name: Material producer name. 
 
Specific Gravity: Specific gravity of each material.  The specific gravity of cement is normally assumed to 

be 3.15.  However, for a blended cement, this value should be verified with the District.  
Specific gravity values for finely divided minerals can be obtained from the Approved List 
of Suppliers for Finely Divided Minerals. 

 
EXAMPLE 
PROBLEM 

The example problem as given in the Course Manual notes that the specific gravity 
for the fly ash component is 2.61. 

Although no specific gravity is given for the cement component, from Section 2.3 in 
the Course Manual, the specific gravity of cement is normally assumed to be 3.15. 
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Step 4.  Finely Divided Minerals & Admixtures Information (continued) 
 
Percent Blend: The blend percentage must be entered for each material, totaling 100.  For example, 

when blending fly ash and cement at 20 and 80 percent, respectively, enter a "20" for the 
fly ash and an "80" for the cement. 

 
EXAMPLE 
PROBLEM 

First, we have to determine if we need to mitigate for alkali-silica reaction (ASR): 
 

From Section 2.4.3 in the Course Manual, it is determined that the component 
aggregates are Group II (fine aggregate expansion in the >0.16% - 0.27% 
range and coarse aggregate expansion ≤0.16%). Thus, we are required to use 
Mix Option 1, 2, 3, 4, or 5. 

 
Because the example problem as given notes that the mix will utilize a cement 
with alkali content >0.60% and a Class C fly ash, we will use Mix Option 2. 

 
Mix Option 2 requires a minimum 25.0 percent Class C fly ash. 

 
Furthermore, from Section 2.4.1.1 in the Course Manual, the Class C fly ash 
component can replace up to 30 percent of the cement. 
 
Thus, it is decided to use 30 percent fly ash since fly ash is cheaper than cement, 
and will provide the most economical mix. 
 
Because the total Percent Blend must equal 100, enter 70.0 for the cement and 
30.0 for the fly ash. 

 
Replacement Ratio: (Optional) Enter the replacement ratio for each finely divided mineral, if applicable.  If left 

blank, the default value of “1.00” will be used. 
 
 
Step 5.  Admixtures Information 
 
Material Code: Enter admixture material codes here.  The 5-digit material code for admixtures can be 

found on the Approved List of Concrete Admixtures. 
 
Admixture Type: Choose admixture type. 
 
Admixture Name: Enter admixture product name here. 
 
Remarks:  Enter key information regarding proposed dosage rates, dosing procedures, etc. 
 
 
Step 6.  General Mixture Remarks 
 
Remarks: Enter any pertinent information not already covered.  When required to mitigate for alkali-

silica reaction (ASR), indicate the mixture option selected. 
 

EXAMPLE 
PROBLEM 

Because we are required to mitigate for alkali-silica reaction, we must indicate the 
mixture option selected. 
 
Enter ASR Mix Option 2, 30% fly ash. 

 
 
Latex Admixture Information (only required for mix designs using a latex admixture) 
 
Batch Dosage:  Enter latex admixture dosage in terms of gallons per cubic yard (liters per cubic meter). 
Specific Gravity: Enter manufacturer’s specific gravity for the latex admixture. 
% Solids:  Enter manufacturer’s percent solids for the latex admixture. 
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Design Report 
Given the inputs, the mix design proportions are calculated and reported.  Three design reports are generated: 
one in English units of measure, one in metric (SI), and one formatted per the Department’s MISTIC database 
requirements.  Please consult your District for which report(s) to submit for approval. 

ENGLISH UNITS DESIGN REPORT 

 

 

METRIC UNITS DESIGN REPORT 
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MISTIC DESIGN REPORT 

 
Note:  The MISTIC Report has three input fields to be completed upon receiving approval from the District. 
 
 
Additionally, there is a tab for help determining the percent water adjustment taking into account various factors.  
However, this table is for informational purposes only.  The water adjustment calculated using this table is not 
referenced by any of the spreadsheet’s mix design calculations.  To use the water adjustment calculated using 
this table, the value must be entered on the Design Variable tab. 
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Changing Macro Security Settings in Microsoft Excel 
 

Note: Any macro settings changes you make in Excel apply only to Excel and do not affect any 
 other Office program. 
 
 
To change the macro security settings in Excel 2007/2010: 

 
1. On the Developer tab*, in the Code group, click Macro Security. 

2. In the Macro Settings category, under Macro Settings, click the 2nd option to Disable all 
macros with notification. 

This option initially disables macros, but alerts you if macros are present. This way, you can 
choose when to enable the macros on a case by case basis. 

3. Now, close Excel, and re-open the PCC Mix Design spreadsheet. 

You should now get a Security Warning (below), click the Options button, then click to Enable 
this content, and finally click OK to close the window. 

 

Office 2007 Office 2010 

 

*  If the Developer tab is not displayed… 

For Excel 2007: 

1. Click the Microsoft Office Button 

2. Click Excel Options (bottom right corner) 

3. In the Popular category, under Top options 
for working with Excel, click Show 
Developer tab in the Ribbon. 

For Excel 2010: 

1. Click the File tab, click Options, and then 
click the Customize Ribbon category. 

2. In the Main Tabs list, check the 
Developer, and then click OK. 

3. Click any other tab to return to your file. 
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Changing Macro Security Settings in Microsoft Excel 
(continued) 

Older versions of Excel: 

1. To access the macro security settings in older version of Excel, go to the Tools menu, Options, 
Security tab, and click on the Macro Security button.  The Security window will open as 
shown: 

 

 
 

2. Click on Medium, then click OK, and close Excel. 

3. Re-open the PCC Mix Design spreadsheet.  At Medium, whenever you open a file that has 
macros, a Security Warning (below) appears: click Enable Macros.  The file opens and is a 
trusted document. 

 

 
 
 


